VMware AirWatch Mobile Email Management Guide

Enabling mobile access to your organization's email

Workspace ONE UEM v9.7

Have documentation feedback? Submit a Documentation Feedback support ticket using the Support Wizard on support.air-watch.com.

Copyright © 2018 VMware, Inc. All rights reserved. This product is protected by copyright and intellectual property laws in the United States and other countries as well as by international treaties. VMware products are covered by one or more patents listed at http://www.vmware.com/go/patents.

VMware is a registered trademark or trademark of VMware, Inc. in the United States and other jurisdictions. All other marks and names mentioned herein may be trademarks of their respective companies.
Table of Contents

Chapter 1: Introduction to Mobile Email Management ................................................. 4
  Challenges ................................................................................................................. 4
  Advantages of Mobile Email Management (MEM) ...................................................... 4
  MEM Requirements ..................................................................................................... 5

Chapter 2: Email Infrastructure Management ............................................................... 6
  Email Deployment Types ............................................................................................... 6
  Secure Email Gateway Proxy Model ........................................................................... 7
  Direct PowerShell Model .............................................................................................. 7
  Direct Gmail Model ...................................................................................................... 8
  MEM Deployment Model Matrix .................................................................................. 10
  Workspace ONE UEM Recommendations ................................................................ 13

Chapter 3: Email Migration to Workspace ONE UEM .................................................. 15
  Migrate to Secure Email Gateway .............................................................................. 15
  Migrate to PowerShell .................................................................................................. 16
  Migrate to Gmail .......................................................................................................... 17
  Migrate Devices .......................................................................................................... 17

Chapter 4: Configure Mobile Email Management Deployment .................................... 18

Chapter 5: Device Assignment to Mobile Email Management (MEM) ......................... 21
  Devices with Exchange Active Sync (EAS) profile ..................................................... 21
  Device Sync up ............................................................................................................ 22

Chapter 6: Email Profiles ............................................................................................. 23
  EAS Profiles ................................................................................................................ 23
  Configure an EAS Mail Profile using Native Mail Client (iOS) .................................... 25
  Configure an EAS Mail Profile using AirWatch Inbox (iOS) ........................................ 26
  Exchange ActiveSync Profile (Windows Desktop) ...................................................... 28

Chapter 7: Enable Certificate-Based Email .................................................................. 33
Chapter 8: Email Access Control Enforcement ................................................................. 35

Email Compliance Policies ................................................................................................. 35
Activate an Email Compliance Policy .................................................................................. 36
Email Content, Attachments & Hyperlinks Protection ....................................................... 39
Enable Email Security Classification .................................................................................. 39
Enable Email Attachment Protection .................................................................................. 40
Enable Hyperlink Protection ............................................................................................... 42

Chapter 9: Email Management .......................................................................................... 43

Email Dashboard .................................................................................................................. 43
Email List View ................................................................................................................... 43
Chapter 1: Introduction to Mobile Email Management

The ability to view corporate data on your device provides a level of convenience and improves productivity, but also presents security and deployment challenges. To overcome such challenges, VMware AirWatch® Mobile Email Management™ (MEM) solution delivers comprehensive security for your corporate email infrastructure.

Challenges

Mobile email provides benefits and at the same time presents bigger challenges.

- Provisioning email across different device types, operating systems, and email clients.
- Securing email access over unsecured networks.
- Protecting sensitive information from third-party apps.
- Restricting email access from unauthorized, lost, or stolen devices.
- Preventing email attachments from being lost and disseminated through the third-party reader apps when they are viewed.

Advantages of Mobile Email Management (MEM)

VMware AirWatch® MEM provides all the key factors of a successful and secure mobile email deployment:

- Enforce SSL security.
- Configure the email over-the-air.
- Discover existing unmanaged devices.
- Protect email from data loss.
- Block unmanaged devices from accessing email.
- Restrict email access to only company-approved devices.
- Use certificate integration and revocation.

**MEM Requirements**

Know the supported web browsers for the Workspace ONE UEM console before you proceed with the VMware AirWatch® Mobile Email Management™ (MEM) solution.

**Disclaimer**

Integration with the third-party product is not guaranteed and dependent upon the proper functioning of those third-party solutions.

**Supported Browsers**

The Workspace ONE Unified Endpoint Management (UEM) console supports the latest stable builds of the following web browsers.

- Chrome
- Firefox
- Safari
- Internet Explorer 11
- Microsoft Edge

**Note:** If using IE to access the UEM console, navigate to Control Panel > Settings > Internet Options > Security and ensure you have a security level or custom security level that includes the Font Download option being set to Enabled.

If you are using a browser older than those listed above, upgrade your browser to guarantee the performance of the UEM console. Comprehensive platform testing has been performed to ensure functionality using these web browsers. The UEM console may experience minor issues if you choose to run it in a non-certified browser.
Chapter 2: Email Infrastructure Management

Email Deployment Types

Workspace ONE UEM offers two types of deployment models with which you can protect and manage your email infrastructure. Using these deployment models with the email policies you define in the UEM console, you can effectively manage your mobile devices by allowing or blocking the email access.

In the proxy model, a separate server called the SEG proxy server is placed between the Workspace ONE server and the corporate email server. This proxy server filters all the requests from the devices to the email server and relays the traffic only from the approved devices. This way the corporate email server is protected as it does not directly communicate with the mobile devices.

The SEG Proxy deployment model can be configured on two platforms: Classic and V2. Though the functionality of both the platforms are the same, V2 platform assures improved performance over the Classic platform.

In the direct model approach, there is no proxy server involved and Workspace ONE UEM communicates directly with the email servers. The absence of proxy server simplifies the installation and configuration steps in this model.

The table provides the list of email servers that are best compatible with the two deployment models.

<table>
<thead>
<tr>
<th>Deployment Model</th>
<th>Configuration Mode</th>
<th>Mail Infrastructure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Secure Email Gateway - V2 Platform</td>
<td>Microsoft Exchange 2010/2013/2016 Exchange Office 365</td>
</tr>
<tr>
<td>Direct Model</td>
<td>PowerShell Model</td>
<td>Microsoft Exchange 2010/2013/2016 Microsoft Office 365</td>
</tr>
<tr>
<td></td>
<td>Gmail Model</td>
<td>Gmail</td>
</tr>
</tbody>
</table>
Note: Workspace ONE UEM only supports the versions of third-party email servers currently supported by the email server provider. When the provider deprecates a server version, Workspace ONE UEM no longer supports integration with that version.

Secure Email Gateway Proxy Model

The Secure Email Gateway (SEG) proxy server is a separate server installed in-line with your existing email server to proxy all email traffic going to mobile devices. Based on the settings you define in the UEM console, the SEG Proxy server makes allow or block decisions for every mobile device it manages.

The SEG Proxy server filters all communication requests to the corporate email server and relays traffic only from approved devices. This relay protects the corporate email server by not allowing any devices to communicate with it.

Install the SEG server in your network so that it is in-line with the email traffic of the corporation. You can also install it in a Demilitarized Zone (DMZ) or behind a reverse proxy. You must host the SEG server in your data center, regardless of whether your Workspace ONE MDM server is in the cloud or on premises.

Direct PowerShell Model

In the PowerShell model, Workspace ONE UEM adopts a PowerShell administrator role and issues commands to the Exchange ActiveSync (EAS) infrastructure to permit or deny email access based on the policies defined in the UEM console. PowerShell deployments do not require a separate email proxy server and the installation process is simpler.

PowerShell deployments are for organizations using Microsoft Exchange 2010, 2013, 2016, or Office 365.

In the setup, where Office 365 the cloud email server is used, the Workspace ONE server sets up the PowerShell session directly with the email server.
In the setup, where the Workspace ONE server is on the cloud and the Exchange server is on premise, Workspace ONE server issues the PowerShell commands. The VMware Enterprise Systems Connector sets up the PowerShell session with the email server.

When both the Workspace ONE server and the email server are on premise, the Workspace ONE server sets up the PowerShell session directly with the email server. Here, there is no VMware Enterprise Systems Connector server required unless the Workspace ONE server cannot communicate with the email server directly.

For assistance in choosing between the Secure Email Gateway and PowerShell deployment models, see Workspace ONE UEM Recommendations on page 13.

**Direct Gmail Model**

Organizations using the Gmail infrastructure might be familiar with the challenge of securing email endpoints for Gmail and preventing mail from circumventing the secure endpoint. Workspace ONE UEM addresses these challenges by
providing a flexible and safe method to integrate your email infrastructure.

In the direct Gmail deployment model, Workspace ONE server communicates directly with Google. Depending on the security needs, you can choose to store the Google password in the Workspace ONE database or remove it from the database.

In the password retention or storing configuration, Workspace ONE UEM stores the Google password in its database. When the device is non-compliant, Workspace ONE UEM resets the password on Google preventing the user from logging into other device. When the device is back to compliant status, Workspace ONE UEM resets the old password on the Google server and the user can log in using the old password.

In the password removal configuration, Workspace ONE UEM does not store the Google password in its database. When the device is non-compliant, the email profile is removed from the user’s device preventing the user from receiving emails. When the device is back to compliant status, Workspace ONE UEM triggers a new password, sends it to Google and the device through the email profile.
MEM Deployment Model Matrix

Office 365 requires more configuration for the SEG Proxy model. Workspace ONE UEM recommends the Direct model of integration for Cloud-based email servers. Refer the Workspace ONE UEM Recommendations on page 13 section for more details.

✓ Supported □ Not supported by Workspace ONE UEM
X Feature not available N/A Not Applicable

<table>
<thead>
<tr>
<th>SEG Proxy Model</th>
<th>Direct Model</th>
</tr>
</thead>
</table>

**Email Security Tools**

**Enforced Security Settings**

<table>
<thead>
<tr>
<th>Feature</th>
<th>SEG Proxy Model</th>
<th>Direct Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use digital signatures through S/MIME capability</td>
<td>✓ □ □</td>
<td>✓ ✓ N/A</td>
</tr>
<tr>
<td>Protect sensitive data through forced encryption</td>
<td>✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
<tr>
<td>Enforce SSL Security</td>
<td>✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
</tbody>
</table>

**Email Attachment & Hyperlinks Security**

<table>
<thead>
<tr>
<th>Feature</th>
<th>SEG Proxy Model</th>
<th>Direct Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enforce attachments and hyperlinks to open in VMware Content Locker or VMware Browser only</td>
<td>✓ ✓* ✓</td>
<td>X X X</td>
</tr>
</tbody>
</table>

**Automatic Email Configuration**

<table>
<thead>
<tr>
<th>Feature</th>
<th>SEG Proxy Model</th>
<th>Direct Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure the email over-the-air on device</td>
<td>✓ ✓ ✓ ✓ ✓ ✓ ✓</td>
<td></td>
</tr>
</tbody>
</table>

**Email Access Control**

<table>
<thead>
<tr>
<th>Feature</th>
<th>SEG Proxy Model</th>
<th>Direct Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block unmanaged devices from accessing email</td>
<td>✓ ✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
<tr>
<td>Discover existing unmanaged devices</td>
<td>✓ ✓ ✓ ✓</td>
<td>✓ ✓ N/A</td>
</tr>
<tr>
<td>Email access with customizable compliance policies</td>
<td>✓ ✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
<tr>
<td>Require device encryption for email access</td>
<td>✓ ✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
<tr>
<td>Prevent compromised devices from email access</td>
<td>✓ ✓ ✓ ✓</td>
<td>✓ ✓ ✓</td>
</tr>
<tr>
<td>Feature</td>
<td>SEG Proxy Model</td>
<td>Direct Model</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Allow / block email - Mail client</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Allow / block email - User</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Allow / block email - Device model</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Allow / block email - Device OS</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Allow / block email - EAS Device type</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Management Visibility</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email traffic statistics</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Email clients statistics</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Certificate Management</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CA Integration / revocation</td>
<td>✓</td>
<td>□</td>
</tr>
<tr>
<td>Architecture</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inline gateway (Proxy)</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Exchange PowerShell</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Password management for Gmail</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Directory API Integration for Gmail</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>Supported</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VMware Boxer for iOS and Android [*]</td>
<td>✓</td>
<td>□</td>
</tr>
<tr>
<td>AirWatch Inbox for iOS</td>
<td>✓</td>
<td>□</td>
</tr>
<tr>
<td>SEG Proxy Model</td>
<td>Direct Model</td>
<td></td>
</tr>
<tr>
<td>----------------------------------</td>
<td>----------------------------------</td>
<td></td>
</tr>
<tr>
<td>AirWatch Inbox for Android</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>AirWatch Inbox for Windows Desktop+</td>
<td>✓+</td>
<td>□</td>
</tr>
<tr>
<td>iOS Native Email Client</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Android Native Email Client**</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Mobile Native Email Client</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Phone</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Blackberry 10***</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>iOS Touchdown*</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Android Touchdown</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Android Lotus Notes Client*</td>
<td>N/A</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Email Attachments & Hyperlinks security is not supported on the Android Lotus Notes client and iOS Touchdown client

**Android native email client supports SAFE, HTC Pro2, LG Optimus Pro, and Intuition devices only

***EAS profile is not supported

+ Exchange 2003 is not supported

^ Exchange 2003, Require ActiveSync Profile, and Multi MEM are not supported for VMware Boxer.
Workspace ONE UEM Recommendations

The features that Workspace ONE UEM supports and the suitable deployment sizes are listed in this section. Use the decision matrix to choose the deployment that best suits your need.

Attachment Encryption

With enforced attachment encryption on your mobile devices, Workspace ONE UEM can help keep your email attachments secure without hindering the end users' experience.

<table>
<thead>
<tr>
<th></th>
<th>Native</th>
<th>AirWatch Inbox</th>
<th>Touchdown</th>
<th>Traveler</th>
<th>VMware Boxer</th>
</tr>
</thead>
<tbody>
<tr>
<td>iOS</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Android</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Windows Phone*</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*If your deployment includes Windows Phone 8/8.1/RT devices, use attachment encryption.

SEG supports attachment encryption and hyperlink transformation on Boxer, only if these features are enabled for the Boxer app configuration on the UEM console.

SEG supports attachment encryption with Exchange 2010/2013/2016 and Office 365.

Email Management

The list gives you the greatest level of security with the easiest deployment and management.

<table>
<thead>
<tr>
<th></th>
<th>G mail</th>
<th>PowerShell</th>
<th>Secure Email Gateway (SEG)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Cloud Mail Infrastructure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Office 365</td>
<td>✓ **</td>
<td>✓ ^</td>
<td>✓ ^</td>
</tr>
<tr>
<td>Gmail</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>On-premises Email Infrastructure</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exchange 2010</td>
<td>✓ ^</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exchange 2013</td>
<td>✓ ^</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exchange 2016</td>
<td>✓ ^</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lotus Notes</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Novel GroupWise</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

^Use the Secure Email Gateway (SEG) for all on-premises email infrastructures with deployments of more than 100,000 devices. For deployments of less than 100,000 devices, using PowerShell is another option for your email management. Refer to the Secure Email Gateway vs. PowerShell Decision Matrix.

**The threshold for PowerShell implementations is based on the most recent set of completed performance tests, and can change on a release by release basis. Deployments up to 50,000 devices can expect reasonably quick sync and run compliance time frames (less than three hours). As the deployment size expands closer to 100,000 devices, then administrators can expect the sync and run compliance processes to continue to increase in the 3–7 hour time frame.
Secure Email Gateway vs PowerShell Decision Matrix

The matrix informs you about the deployment features of SEG and PowerShell to help you choose which deployment suits your need.

<table>
<thead>
<tr>
<th>Pros</th>
<th>Cons</th>
</tr>
</thead>
</table>
| SEG  | • Additional server(s) required  
      | • ADFS must be configured to prevent end users from connecting directly to Office 365 (around SEG)*  
      | • No real-time compliance sync  
      | • Not for large deployments (more than 100000)  
      | • AirWatch Inbox must be used to containerize attachments and hyperlinks in VMware Content Locker and VMware Browser respectively |
|  | + Microsoft suggests using Active Directory Federated Services (ADFS) for preventing direct access to Office 365 email accounts. |
| PowerShell | • No additional on-premises server required for email management  
      | • Mail traffic is not routed to an on-premises server before being routed to Office 365, so ADFS is not required |

Connecting IBM Notes Traveler Server through AirWatch Inbox

If you are using a Workspace ONE UEM Exchange ActiveSync profile to connect to an IBM Notes Traveler server through the Android AirWatch Inbox, you might receive an ‘HTTP 449’ response. This response is seen when an Android device attempts to connect to the Traveler server. This ‘HTTP 449’ error occurs if the ActiveSync policy headers sent from the client (and enforced through Workspace ONE UEM console) do not match the policy headers supported by the Traveler server.

To resolve such issues, follow these steps:

1. Add the following flag to the notes.ini file on the Traveler server.

   ```text
   NTS_AS_PROVISION_EXEMPT_USER_AGENT_REGEx=(AirWatch*) | (Apple*; AWInbox*)
   ```

2. Next, restart the Traveler server.

Adding this flag disables Traveler from enforcing any policies to the AirWatch Inbox. You must use Workspace ONE UEM for applying the required policies to the app.

Devices that use policies provisioned directly by Traveler (that is, not configured through Workspace ONE UEM), are not affected.

**Note:** If you are using IBM Notes Traveler with SEG 7.3+, then the IBM Notes Traveler requires the Microsoft-Server-ActiveSync website support.
Chapter 3: Email Migration to Workspace ONE UEM

With Workspace ONE UEM, it is easy to migrate devices from your existing email infrastructure to one of the Mobile Email Management (MEM) deployment models: Secure Email Gateway (SEG), PowerShell, or Gmail. By migrating to these models, you can enforce email access control policies ensuring email access is provided only to the approved users and devices.

Migrate to Secure Email Gateway

Email migration to Secure Email Gateway (SEG) enables users' access to emails only through the SEG proxy. It enforces email access control policies, giving access only to approved users and devices. Attachment encryption policies ensure data security.

To migrate email to the SEG environment, follow the steps:

1. Configure SEG at your required organization group under Global in the UEM console.
2. Download and install SEG.
3. Test the SEG functionality using the email compliance policy.
4. Disable all compliance policies temporarily.
5. Ask all users to enroll their devices into Workspace ONE UEM.
6. Provision a new email profile (with the SEG server URL as the hostname) to all the enrolled devices.
7. Periodically, remind users with unmanaged devices to enroll into Workspace ONE UEM.
8. To block EAS access to the mail server on a specific date, modify firewall (or Threat Management Gateway) rules. It ensures that mobile devices are blocked from accessing the mail server directly.

Existing Webmail, Outlook Web Access (OWA), and other email clients continue to access the mail server.

9. To begin enforcing access control and data security on devices attempting to access corporate email, enable email policies on the SEG server.
Migrate to PowerShell

By migrating to PowerShell, you can secure your devices and sync the devices with Exchange or Office 365 for emails. PowerShell environment discovers managed and unmanaged devices and with the help of email access control policies gives access to only approved users and devices.

To migrate to PowerShell:

1. Configure PowerShell integration at your required organization group under Global in the UEM console.
2. Configure the integration with user groups (either custom or pre-defined).
3. Test the PowerShell functionality with a subset of users (for example, test users) to ensure the following features work:
   - Syncing with the email server to discover devices.
   - Access control in real time.
4. Disable all compliance policies temporarily.
5. Provision a new email profile to all devices that have enrolled into Workspace ONE UEM with the email server hostname.
   - To remove the email profile from the device using Device Compliance policies, complete this step.
6. To discover all devices (managed and unmanaged) that are syncing for email, sync with the email server.
7. To enroll into Workspace ONE UEM, periodically remind users with unmanaged devices.
8. To block email access from all non-compliant devices on a specific date including the unmanaged devices, activate and enforce compliance rules.
9. To block all devices by default, set up the email server.
10. Sync with the email server to retrieve a list of allowed and blocked devices (as a result of the previous policy change) and Run Compliance against these devices. When run compliance is done, the Email Dashboard displays:
   - Unmanaged devices as blocked.
   - Managed devices are allowed for email.

Workaround for Boxer Flexible Deployment

The Flexible Deployment feature of Boxer enables you to create different assignments for smart groups in your Organization Group.

If PowerShell is being used for Email Management, then when migrating between Exchange environments or to Office 365, email access might be blocked for Boxer. To avoid blocking email access, create a Device Access Rule in Exchange to allow Workspace ONE UEM managed Boxer configurations.

You can follow these steps to configure a device access rule for Office 365 to allow email access to devices installed with Boxer:

1. Log in to the Exchange Control Panel.
2. Select Mobile.
3. To add a rule, select the '+ icon under **Device Access Rules**.

4. From the Device family, select **browse**, and then select **BoxerManagediPhone, BoxerManaged iPad, or BoxerManagedAndroid**. Select **OK**. Repeat this step for other BoxerManaged devices.

5. From **Only this model**, select **All models**.

6. Select **Allow access** for the rule.

To prevent the compliance restriction during MEM migration, follow the preceding instructions on other Exchange versions.

### Migrate to Gmail

By migrating to Gmail, you can sync your devices with the Gmail server. You can integrate your Gmail with or without a Secure Email Gateway (SEG) or directly with the Directory APIs.

1. Prepare Gmail for Workspace ONE UEM integration.

2. Enable the Single Sign On (SSO) option on Gmail or create the Service Account certificate.

3. Configure the Gmail integration from the UEM console using the MEM configuration wizard.

4. Provision EAS profiles to users with the new randomized password. Devices that do not receive this profile are automatically blocked from accessing Gmail.

### Migrate Devices

Workspace ONE UEM can migrate devices across organization groups and MEM deployments. For example, you want to migrate all your devices managed by 'MEM deployment A' to 'MEM deployment B'.

To migrate the devices:

1. Navigate to **Email Dashboard**.

2. Filter the managed devices that are under your present 'MEM deployment'.

3. In the **List View** page, select all the devices and select the **Migrate Devices** option from the **Administration** drop-down menu.

4. In the **Migrate Devices Confirmation** page, enter the given key code to confirm the migration and select the configuration to which you want to deploy the devices. Select **Continue**.

After you perform these steps, Workspace ONE UEM automatically removes the earlier Exchange ActiveSync (EAS) profile and pushes the new EAS profile with the target deployment group. The device then connects to its new deployment group. Workspace ONE UEM then displays the updated memconfigID for the device on the Email Dashboard.
Chapter 4: Configure Mobile Email Management Deployment

You can integrate your email infrastructure in a few simple steps using the Mobile Email Management (MEM) configuration wizard. MEM can only be configured at a parent organization group and cannot be overridden at a child organization group. One MEM configuration can be associated with a single or multiple Exchange ActiveSync (EAS) profiles.

To configure the MEM deployment:

1. Navigate to Email > Settings, and then select Configure.

2. Select the deployment model and then select the email type. Select Next.
   - If Proxy is the deployment model, select the Gateway Platform:
     - For Classic platform, the email types that can be selected are:
       - Exchange
       - Google Apps using Password Provisioning
       - Novell Groupwise
       - IBM Notes.
     - For V2 platform, the email type available is Exchange.
   - If Direct is the deployment model, then the email types that can be selected are:
     - Exchange
     - Google App with Direct API
     - Google App using Password Provisioning - Select With Password Retention or Without Password Retention as the Gmail Deployment Type.

For more information on the deployment methods, see Email Infrastructure Management on page 6.
3. Enter the details for the chosen deployment type:
   - For SEG deployments:
     - Enter a friendly name for this deployment.
     - Enter the SEG proxy server details.
   - For PowerShell deployments:
     - Enter a friendly name for this deployment.
     - Enter the details of the PowerShell server, authentication, and sync settings.
   - For Gmail:
     - Enter a friendly name for this deployment.
     - Enter the details of the Gmail settings, authentication, Gmail Directory APIs Integration, and SEG proxy settings.
4. Associate a template EAS profile with the MEM deployment and select Next.
   - Create a template EAS profile for this deployment. New template profiles are not published to devices automatically. You can publish profiles to your devices from the Profiles page.
   - Associate an existing profile to this deployment. This is mandatory if more than one MEM deployment is to be configured at a single organization group.
5. The MEM Config Summary page displays the configuration details. Save the settings.
6. Once saved, you can add the advanced settings to this deployment.
   - Select the Advanced icon corresponding to your deployment.
   - Configure the available settings for the user mailboxes as per requirement in the Mobile Email Management Advanced Configuration page.
   - Select Save.
7. To configure multiple MEM deployments, select Add (available on the Mobile Email Management Configuration main page) and perform steps 2–7. In a SEG deployment, you may assign a particular configuration as the default using the option Set as default available under ▼.
Mobile Email Management Configuration

AirWatch Mobile Email Management allows you to manage email access and data to mobile devices. Configure one or more MEM deployments at your organization group and use email policies to manage email for devices. For more information, refer to the AirWatch Mobile Email Management Guide.

<table>
<thead>
<tr>
<th>Active</th>
<th>MEM Friendly Name</th>
<th>Email Server Type</th>
<th>Hostname</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Server A</td>
<td>Microsoft Exchange</td>
<td><a href="https://acme/powershell">https://acme/powershell</a></td>
</tr>
<tr>
<td></td>
<td>Server B</td>
<td>Microsoft Exchange</td>
<td><a href="https://acmea/powershell">https://acmea/powershell</a></td>
</tr>
</tbody>
</table>

**Note:**

a. You should create mutually exclusive user groups when connecting multiple PowerShell environments to the same Exchange server.
b. Use different domains in the configuration when connecting multiple Gmail environments.
d. Consider connecting SEG and PowerShell integration to the same email environment only during migration of MEM deployments with appropriate settings. Workspace ONE Support can help you with this implementation.
Chapter 5: Device Assignment to Mobile Email Management (MEM)

Device enrollments, assignment of email profiles to devices, and change in the device compliance status impacts Mobile Email Management (MEM). MEM configurations are assigned to devices based on the EAS profiles present on the devices. The Managed and Require ActiveSync Profile compliance policies ensures that unmanaged and manual configurations remain unpermitted.

Devices with Exchange Active Sync (EAS) profile

When a device with an EAS profile associates to a particular MEM configuration, Workspace ONE UEM sends policy updates to that MEM configuration. This feature facilitates migrations and multiple MEM configurations where one or more email environments are managed.

Regardless of the email client, all Google MEM models require an EAS profile. For new installs, associating an EAS profile to a MEM configuration is mandatory. For upgrades, an admin has to associate an EAS profile to the MEM configuration upon completion of the upgrade process.

SEG Proxy Integrated

Workspace ONE UEM sends a broadcast message to all the MEM configurations of the organization group to which the device has enrolled. This message states the compliance status of the device. When compliance changes, an updated message is sent. When the device connects to a particular SEG server, the SEG recognizes the device from the broadcast message sent earlier. The SEG Proxy then reports the device as discovered to VMware AirWatch. Workspace ONE UEM then associates the device with the MEM Configuration for SEG and displays it on the Email Dashboard.

If multiple SEG servers are load balanced, single policy broadcast messages apply to only one SEG. This includes the messages sent from the UEM Console to SEG upon enrollment, compliance violation, or correction. Use Delta Sync with a refresh interval of ten minutes to facilitate newly enrolled or compliant devices. These devices experience a waiting period of maximum ten minutes before email begins to sync.

Benefits:
- Updated policies from the same API source for all SEG servers.
- Smaller performance impact on API server.
- Reduced implementation or maintenance complexity compared to the SEG clustering model.
- Fewer failure points as each SEG is responsible for its own policy sets.
- Improved user experience.

**PowerShell Integrated**

PowerShell MEM configurations behave the same as SEG in terms of policy updates. For migrations to PowerShell, it is important that new profiles are associated to the PowerShell MEM configuration. Associating a new profile reduces unnecessary communication with the previous MEM configuration.

**Gmail Integrated**

Profiles are required for this type of deployment except when integrating with Google Directory APIs. Unless the devices are provisioned with the profiles, the configured Gmail deployment does not identify or manage the device.

**Device Sync up**

Once you configure a Mobile Email Management (MEM) deployment, the devices of the associated organization group sync up with MEM. You can view the devices detail and status on the Email Dashboard page of the UEM console.

When the devices appear on the dashboard depends on the deployment models the devices are assigned to. Devices managed with the SEG Proxy appear on the Dashboard when the SEG Proxy reports the device as connected and managed. Those managed with PowerShell appear on the Dashboard when Workspace ONE UEM sends a PowerShell cmdlet, allowing the device to connect to email. Devices managed with Gmail appear on the Dashboard when the SEG Proxy Workspace ONE UEM EAS profile is queued up for the device.

The Email Dashboard shows one of the following statuses:

- **Managed Assigned** - Enrolled devices with identified memconfigID.
- **Managed Unassigned** - Enrolled devices for which the memConfigID has not yet been identified through profile assignment or auto discovery.
- **Unmanaged Discovered** - Devices not yet enrolled in Workspace ONE UEM and a specific MEM configuration at the organization group that has discovered them.
Chapter 6: Email Profiles

EAS Profiles

Deploy EAS Mail using Native Mail Client (Android (Legacy))

Use the following steps to create a configuration profile for the Native Mail Client:

1. Navigate to Devices > Profiles & Resources > Profiles > Add > Add Profile > Android (Legacy).
2. Select Device to deploy your profile to a device.
3. Configure the profile’s General settings.
4. Select the Exchange ActiveSync payload.
5. Configure Exchange ActiveSync settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Client</td>
<td>Select Native Mail Client as the account type.</td>
</tr>
<tr>
<td>Account Name</td>
<td>Enter a description for the mail account.</td>
</tr>
<tr>
<td>Exchange ActiveSync Host</td>
<td>Enter the external URL of your company’s ActiveSync server. The ActiveSync server can be any mail server that implements the ActiveSync protocol, such as IBM Notes Traveler, Novell Data Synchronizer, and Microsoft Exchange. In the case of Secure Email Gateway (SEG) deployments, use the SEG URL and not the email server URL.</td>
</tr>
<tr>
<td>Ignore SSL Errors</td>
<td>Enable to allow devices to ignore SSL errors for Agent processes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Login Information</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>Enter the end-user's domain. You can use the Lookup Values instead of creating individual profiles for each end user.</td>
</tr>
<tr>
<td>User</td>
<td>Enter the end-user's username. You can use the Lookup Values instead of creating individual profiles for each end user.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enter the end-user's email address. You can use the Lookup Values instead of creating individual profiles for each end user.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the password for the end user. You can use the Lookup Values instead of creating individual profiles for each end user.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Identity Certificate</td>
<td>Select (if desired) an Identity Certificate from the drop-down if you require the end user to pass a certificate in order to connect to the Exchange ActiveSync, otherwise select None (default).</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Past Days of Mail to Sync</td>
<td>Select the number of days worth of past mail to sync with device.</td>
</tr>
<tr>
<td>Past Days of Calendar to Sync</td>
<td>Select the number of past days to sync on the device calendar.</td>
</tr>
<tr>
<td>Sync Calendar</td>
<td>Enable to allow calendars to sync with device.</td>
</tr>
<tr>
<td>Sync Contacts</td>
<td>Enable to allow contacts to sync with device.</td>
</tr>
<tr>
<td>Allow Sync Tasks</td>
<td>Enable to allow tasks to sync with device.</td>
</tr>
<tr>
<td>Maximum Email Truncation Size</td>
<td>Specify the size beyond which e-mail messages are truncated when they are synced to the devices.</td>
</tr>
<tr>
<td>Email Signature</td>
<td>Enter the email signature to be displayed on outgoing emails.</td>
</tr>
<tr>
<td><strong>Restrictions</strong></td>
<td></td>
</tr>
<tr>
<td>Allow Attachments</td>
<td>Enable to allow attachments with email.</td>
</tr>
<tr>
<td>Maximum Attachment Size</td>
<td>Specify the maximum attachment size in MB.</td>
</tr>
<tr>
<td>Allow Email Forwarding</td>
<td>Enable to allow email forwarding.</td>
</tr>
<tr>
<td>Allow HTML Format</td>
<td>Specify whether e-mail synchronized to the device can be in HTML format. If this setting is set to false, all e-mail is converted to plain text.</td>
</tr>
<tr>
<td>Disable screenshots</td>
<td>Enable to disallow screenshot to be taken on the device.</td>
</tr>
<tr>
<td>Sync Interval</td>
<td>Enter the number of minutes between syncs.</td>
</tr>
</tbody>
</table>
### Setting | Description
---|---
**Peak Days for Sync Schedule**
- Schedule the peak week days for syncing and the *Start Time* and *End Time* for sync on selected days.
- Set the frequency of *Sync Schedule Peak* and *Sync Schedule Off Peak*.
  - Choosing *Automatic* syncs email whenever updates occur.
  - Choosing *Manual* only syncs email when selected.
  - Choosing a time value syncs the email on a set schedule.
- Enable *Use SSL, Use TLS* and *Default Account*, if desired.

### S/MIME Settings
Select *Use S/MIME* From here you can select an S/MIME certificate you associate as a *User Certificate* on the *Credentials* payload.

- **S/MIME Certificate** – Select the certificate to be used.
- **Require Encrypted S/MIME Messages** – Enable to require encryption.
- **Require Signed S/MIME Messages** – Enable to require S/MIME signed messages.

Provide a *Migration Host* if you are using S/MIME certificates for encryption.
Select *Save* to save the settings or *Save & Publish* to save and push the profile settings to the required device.

6. Select *Save* to save the settings or *Save & Publish* to save and push the profile settings to the required device.

---

**Configure an EAS Mail Profile using Native Mail Client (iOS)**

Use the following steps to create an email configuration profile for the native mail client on iOS devices.

1. Navigate to *Devices > Profiles & Resources > Profiles > Add*. Select *Apple iOS*.
2. Configure the profile's *General* settings.
3. Select the *Exchange ActiveSync* payload.
4. Select *Native Mail Client* for the *Mail Client*. Fill in the *Account Name* text box with a description of this mail account. Fill in the *Exchange ActiveSync Host* with the external URL of your company's ActiveSync server.
   - The ActiveSync server can be any mail server that implements the ActiveSync protocol, such as Lotus Notes Traveler, Novell Data Synchronizer, and Microsoft Exchange. In the case of Secure Email Gateway (SEG) deployments, use the SEG URL and not the email server URL.
5. Select the *Use SSL* check box to enable Secure Socket Layer use for incoming email traffic.
6. Select the *S/MIME* check box to use more encryption certificates. Prior to enabling this option, ensure you have uploaded necessary certificates under *Credentials* profile settings.
9. Select the Per Message Switch check box to allow end users to choose which individual email messages to sign and encrypt using the native iOS mail client (iOS 8+ supervised only).

7. Fill in the Login Information including Domain Name, Username and Email Address using look-up values. Look-up values pull directly from the user account record. To use the {EmailDomain}, {EmailUserName} {EmailAddress} look-up values, ensure your Workspace ONE UEM user accounts have an email address and email user name defined.

8. Leave the Password field empty to prompt the user to enter a password.

9. Select the Payload Certificate to define a certificate for cert-based authentication after the certificate is added to the Credentials payload.

10. Configure the following Settings and Security optional settings, as necessary:

- Past Days of Mail to Sync – Downloads the defined amount of mail. Note that longer time periods will result in larger data consumption while the device downloads mail.
- Prevent Moving Messages – Disallows moving mail from an Exchange mailbox to another mailbox on the device.
- Prevent Use in 3rd Party Apps – Disallows other apps from using the Exchange mailbox to send message.
- Prevent Recent Address Syncing – Disables suggestions for contacts when sending mail in Exchange.
- Prevent Mail Drop – Disables use of Apple’s Mail Drop feature.

11. Assign a Default Audio Call App that your Native EAS account will use to make calls when you select a phone number in an email message.

12. Select Save and Publish to push the profile to available devices.

**Configure an EAS Mail Profile using AirWatch Inbox (iOS)**

Use the following steps to create a configuration profile for the AirWatch Inbox. For more information about AirWatch Inbox, see the VMware AirWatch Inbox Guide.

1. Navigate to Devices > Profiles & Resources > Profiles.

2. Select Add and select iOS as the platform.

3. Configure the profile’s General settings.

4. Select the Exchange ActiveSync payload and then select the AirWatch Inbox from the Mail Client drop-down.

5. Enter the Exchange ActiveSync Host, which is the information of your EAS server. For example: webmail.Workspace ONE UEMmdm.com.

- Enable Ignore SSL Errors to allow the devices to ignore Secure Socket Layer errors from agent processes.
- Enable Use S/MIME to select the certificate/smart card for signing and encrypting email messages. Before enabling this option, ensure that you have uploaded necessary certificates under the Credentials profile.
settings.
You do not need to upload any certificates if a smart card is selected as the credential source in the Credentials profile settings.

- Select the certificate/smart card to sign only email messages in the S/MIME Certificate text box.
- Select the certificate/smart card to both sign and encrypt email messages in the S/MIME Encryption Certificate text box.
- If the smart card is selected, default information populates the Smart Card Reader Type and Smart Card Type.
- Choose the Smart Card Timeout interval.

6. Enter Login Information to authenticate user connections to your EAS Host. The profile supports lookup values for inserting enrollment user’s information and login information.

7. Configure Settings, such as:

- Enable Calendar
- Enable Contacts
- Caller ID
- Sync Interval – The frequency with which the Workspace ONE UEM Inbox app syncs with the email server.
- Email Notifications – Configure how end users can be notified of new emails. Disabled means they do not receive a notification. You can also trigger the device to play an alert sound, or allow the device to display specific email message details such as the sender, subject, and message preview.

- Past Days of Mail to Sync
- Past Days of Calendar to Sync
- Enable HTML Email
- Email Signature
- Enable Signature Editing

8. Configure a Passcode for Workspace ONE UEM Inbox. You can require an end user to enter a passcode when the Workspace ONE UEM Inbox is opened. This is not the email account password, but the passcode the user enters to access the application. The following passcode settings are available:

- Authentication Type
  To allow iOS users to log in using their Workspace ONE UEM credentials, select Username and Password as the Authentication Type under the Passcode section.
- Passcode Complexity – Determine whether the password is simple or complex.
- Minimum Length – Set the minimum number of characters allowed for the passcode.
- Minimum Number of Complex Characters, if the Complexity is set to Alphanumeric.
- Maximum Passcode Age (days) – Limit the number of days allowed before passcode has to be reset.
• **Passcode History** – Determine the history of passcodes used to prevent the user from reusing passcodes.

• **Auto-Lock Timeout (min)** – Set the number of minutes before the device automatically locks.

• **Maximum Number of Failed Attempts** – Determine the number of passcode entry attempts allowed before the data in Workspace ONE UEM Inbox are erased.

9. Configure more restrictions and security settings. The following restrictions are available:

• **Allow/Disable Copy and Paste**
  - Disable user’s ability to long press email text and copy it to the clipboard.
  - Disable user’s ability to copy text from outside of the email client and paste it into a mail message.

• **Restrict all links to open in the VMware Browser app only**
  Consider using this setting instead of the SEG policy to transform hyperlinks where the use case allows for increased SEG performance.

• **Restrict attachments to open only in the VMware Content Locker**
  Consider using this setting instead of the SEG policy to encrypt attachments where the use case allows for increased SEG performance.

• **Set a Maximum Attachment Size (MB)**

• **Allow Printing**

10. Select **Save & Publish**.

### Username and Password

You can define the user name that is assigned for users to log in to the Workspace ONE UEM Inbox. The user name can be their actual email address or an email user name that is different from their actual email address. When configuring the **Exchange ActiveSync (EAS)** payload in the Workspace ONE UEM **Inbox** profile settings, there is a **User** text box under **Login Information** that you can set to a predefined lookup value.

If you have email user names that are different than user email addresses, you can use the `{EmailUserName}` text box, which corresponds to the email user names imported during directory service integration. Even if your user user names are the same as their email addresses, use the `{EmailUserName}` text box, because it uses email addresses imported through the directory service integration.

### Exchange ActiveSync Profile (Windows Desktop)

The Exchange ActiveSync profiles enable you to configure your Windows Desktop devices to access your Exchange ActiveSync server for email and calendar use.

Strongly consider only using certificates signed by a trusted third-party certificate authority (CA). Mistakes in your certificates expose your otherwise secure connections to potential man-in-the-middle attacks. Such attacks degrade the confidentiality and integrity of data transmitted between product components, and might allow attackers to intercept or alter data in transit.

The Exchange ActiveSync profile supports the native mail client and AirWatch Inbox for Windows Desktop. The configuration changes based on which mail client you use.
Important: Native Mail Client support is only available for Windows 10 devices.

Removing Profile or Enterprise Wiping

If the profile is removed using the remove profile command, compliance policies, or through an enterprise wipe, all email data is deleted, including:

- User account/login information.
- Email message data.
- Contacts and calendar information.
- Attachments that were saved to the internal application storage.

Username and Password

You can define the user name that is assigned for users to log in to the Workspace ONE UEM Inbox. The user name can be their actual email address or an email user name that is different from their actual email address. When configuring the Exchange ActiveSync (EAS) payload in the Workspace ONE UEM Inbox profile settings, there is a User text box under Login Information that you can set to a predefined lookup value.

If you have email user names that are different than user email addresses, you can use the \{EmailUserName\} text box, which corresponds to the email user names imported during directory service integration. Even if your user user names are the same as their email addresses, use the \{EmailUserName\} text box, because it uses email addresses imported through the directory service integration.

Configure an EAS Profile for AirWatch Inbox (Windows Desktop)

Create an Exchange ActiveSync profile to give Windows Desktop devices access to your Exchange ActiveSync server for email and calendar use. The settings change when you use the AirWatch Inbox as your Windows Desktop email client.

Use the following steps to create a configuration profile for the AirWatch Inbox:

1. Navigate to Devices > Profiles > List View > Add and select Add Profile.
2. Select Windows and choose Windows Desktop as the platform.
3. Select User Profile.
4. Configure the profile General settings.
5. Select the Exchange ActiveSync payload. By default, AirWatch Inbox is selected in the Mail Client drop-down menu.
6. Enter the Exchange ActiveSync Host, which is the information of your EAS server. For example: webmail.airwatchmdm.com.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SSL</td>
<td>Enable to send all communications through the Secure Socket Layer.</td>
</tr>
<tr>
<td>Use S/MIME</td>
<td>Enable to store end-user S/MIME certificates. This option is necessary for S/MIME-enabled profiles.</td>
</tr>
<tr>
<td>Settings</td>
<td>Descriptions</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Login Information</strong></td>
<td></td>
</tr>
<tr>
<td>Domain</td>
<td>Enter the email domain.</td>
</tr>
<tr>
<td>User</td>
<td>Enter the email user name.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Enter the email address. This text box is a required setting.</td>
</tr>
<tr>
<td>Password</td>
<td>Enter the email password.</td>
</tr>
<tr>
<td>Payload Certificate</td>
<td>Select the certificate for the EAS payload.</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td></td>
</tr>
<tr>
<td>Require Passcode</td>
<td>Enable to require a passcode when the AirWatch Inbox app opens.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of login credentials required:</td>
</tr>
<tr>
<td></td>
<td>- Passcode</td>
</tr>
<tr>
<td></td>
<td>- Username and Password</td>
</tr>
<tr>
<td>Complexity</td>
<td>Select the level of complexity for the passcode:</td>
</tr>
<tr>
<td></td>
<td>- Simple</td>
</tr>
<tr>
<td></td>
<td>- Alphanumeric</td>
</tr>
<tr>
<td>Minimum Length</td>
<td>Select the minimum number of characters the passcode must have.</td>
</tr>
<tr>
<td>Allow Simple Value</td>
<td>Enable to allow passcodes that do not meet complexity requirements.</td>
</tr>
<tr>
<td>Minimum Number of Complex Characters</td>
<td>Displayed when Complexity is set to Alphanumeric.</td>
</tr>
<tr>
<td>Maximum Age</td>
<td>Select the maximum number of days a passcode may be used.</td>
</tr>
<tr>
<td>History</td>
<td>Select the number of previous passcodes remembered. If a user changes a passcode and it matches a stored previous passcode, the passcode is not accepted.</td>
</tr>
<tr>
<td>Auto Lock When Device Locks</td>
<td>Enable to lock AirWatch Inbox automatically when the device locks.</td>
</tr>
<tr>
<td>Grace Period</td>
<td>Select the number of minutes the app remains open and unlocked before automatically locking.</td>
</tr>
<tr>
<td>Maximum Number of Failed Attempts</td>
<td>Select the number of incorrect passcode entry attempts allowed before the data in AirWatch Inbox is erased.</td>
</tr>
<tr>
<td><strong>Passcode</strong></td>
<td></td>
</tr>
<tr>
<td>Require Passcode</td>
<td>Enable to require a passcode when the AirWatch Inbox app opens.</td>
</tr>
<tr>
<td>Settings</td>
<td>Descriptions</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of login credentials required:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Passcode</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Username and Password</strong></td>
</tr>
<tr>
<td>Complexity</td>
<td>Select the level of complexity for the passcode:</td>
</tr>
<tr>
<td></td>
<td>• Simple</td>
</tr>
<tr>
<td></td>
<td>• Alphanumeric</td>
</tr>
<tr>
<td>Minimum Length</td>
<td>Select the minimum number of characters the passcode must have.</td>
</tr>
<tr>
<td>Allow Simple Value</td>
<td>Enable to allow passcodes that do not meet complexity requirements.</td>
</tr>
<tr>
<td>Minimum Number of Complex Characters</td>
<td>Select the smallest number of non-alphanumeric characters allowed.</td>
</tr>
<tr>
<td></td>
<td>Displayed when <strong>Complexity</strong> is set to <strong>Alphanumeric</strong>.</td>
</tr>
<tr>
<td>Maximum Age</td>
<td>Select the maximum number of days a passcode may be used.</td>
</tr>
<tr>
<td>History</td>
<td>Select the number of previous passcodes remembered.</td>
</tr>
<tr>
<td></td>
<td>If the end user reuses a password within the number of recorded occurrences,</td>
</tr>
<tr>
<td></td>
<td>they cannot reuse that password.</td>
</tr>
<tr>
<td>Auto Lock When Device Locks</td>
<td>Enable to lock AirWatch Inbox when the device locks.</td>
</tr>
<tr>
<td>Grace Period</td>
<td>Select the number of minutes the app remains open and unlocked before</td>
</tr>
<tr>
<td></td>
<td>automatically locking</td>
</tr>
<tr>
<td>Maximum Number of Failed Attempts</td>
<td>Select the number of incorrect passcode entry attempts allowed before the</td>
</tr>
<tr>
<td></td>
<td>data in AirWatch Inbox is erased.</td>
</tr>
<tr>
<td><strong>Restrictions</strong></td>
<td></td>
</tr>
<tr>
<td>Disable Copy-Paste</td>
<td>Enable to restrict the copy/paste actions in AirWatch Inbox:</td>
</tr>
<tr>
<td></td>
<td>• Disable ability to long press email text and copy it to the clipboard.</td>
</tr>
<tr>
<td></td>
<td>• Disable ability to copy text from outside of the email client and paste</td>
</tr>
<tr>
<td></td>
<td>it into a mail message.</td>
</tr>
<tr>
<td>Disable Attachments</td>
<td>Enable to restrict end user from opening attachments inside the AirWatch</td>
</tr>
<tr>
<td>Maximum Attachment Size (MB)</td>
<td>Enter the maximum size (in MB) that a received attachment may be.</td>
</tr>
<tr>
<td>Restrict Domains</td>
<td>Enable to restrict the mail flow to specific domains.</td>
</tr>
<tr>
<td>Restriction Type</td>
<td>Select the type of restriction for email domains.</td>
</tr>
<tr>
<td>Domain Name</td>
<td>Select <strong>Add</strong> to add a domain to the whitelist or blacklist.</td>
</tr>
</tbody>
</table>

7. Select **Save** to keep the profile in the console or **Save & Publish** to push the profile to the devices.
Configure an Exchange ActiveSync Profile (Windows Desktop)

Create an Exchange ActiveSync profile to give Windows Desktop devices access to your Exchange ActiveSync server for email and calendar use.

**Note:** Workspace ONE UEM does not support Outlook 2016 for Exchange ActiveSync profiles.

Use the following steps to create a configuration profile for the native mail client:

1. Navigate to Devices > Profiles > List View > Add and select Add Profile.
2. Select Windows and choose Windows Desktop as the platform.
3. Select User Profile.
4. Configure the profile General settings.
5. Select the Exchange ActiveSync payload.
6. Configure the Exchange ActiveSync settings:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Client</td>
<td>Select the Mail Client that the EAS profile configures.</td>
</tr>
<tr>
<td></td>
<td>Workspace ONE UEM supports the Native Mail Client and AirWatch Inbox.</td>
</tr>
<tr>
<td>Account Name</td>
<td>Enter the name for the Exchange ActiveSync account.</td>
</tr>
<tr>
<td>Exchange ActiveSync Host</td>
<td>Enter the URL or IP Address for the server hosting the EAS.</td>
</tr>
<tr>
<td>Use SSL</td>
<td>Enable to send all communications through the Secure Socket Layer.</td>
</tr>
</tbody>
</table>

**Login Information**

| Domain            | Enter the email domain.                                                     |
|                   | The profile supports lookup values for inserting enrollment user login information. For more information, see Exchange ActiveSync Profile (Windows Desktop) on page 28. |
| Username          | Enter the email user name.                                                  |
| Email Address     | Enter the email address. This text box is a required setting.               |
| Password          | Enter the email password.                                                   |
| Identity Certificate | Select the certificate for the EAS payload.                               |
Chapter 7: Enable Certificate-Based Email

Using certificates over the standard username and password credentials have certain benefits as the certificates provide stronger authentication against unauthorized access. It also eliminates the need for end users to enter in a password or renew one every month. Sensitive emails between recipients can be encrypted through S/MIME or prove your identity through a message signature.

To enable Certificate-based email:

1. Navigate to Devices > Profiles & Resources > Profiles.

2. Select ADD > Add Profile and then select the required platform.
3. Choose the **Credentials** profile setting and configure it.

- **Credential Source** – Select any from the available list.
  - **Upload** – Upload a certificate and enter a name for the certificate.
  - **Defined Certificate Authority** – Select the CA and the certificate template from the drop-down menu for your organization group.
    The certificate authorities and the templates are added for an organization group at Devices > Certificates > Certificate Authorities.

- **User Certificate** – Select the type of S/MIME certificate
  - **S/MIME Signing Certificate**
  - **S/MIME Encryption Certificate**

4. **Save & Publish** the settings.
Chapter 8:
Email Access Control Enforcement

Email Compliance Policies

Once email has been deployed, you can further protect your mobile email by adding access control. The access control feature allows only secure and compliant devices to access your mail infrastructure. The access control is enforced with the help of email compliance policies.

Email compliance policies enhance security by restricting email access to non-compliant, unencrypted, inactive, or unmanaged devices. These policies allow you to provide email access to only the required and approved devices. Email policies also restrict email access based on the device model and the operating systems.

These policies are categorized as General Email Policies, Managed Device Policies, and Email Security Policies. The different policies that fall under each category and the deployments to which they are applicable are listed in the table.

- Applicable - Not Applicable

<table>
<thead>
<tr>
<th>General Email Policies</th>
<th>SEG</th>
<th>PowerShell</th>
<th>Gmail</th>
<th>SEG proxy using password management</th>
<th>Direct Integration using Directory API</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Settings</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Managed Device</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mail Client</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>SEG</td>
<td>PowerShell</td>
<td>Gmail</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----</td>
<td>------------</td>
<td>-------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>User</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>EAS Device Type</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Managed Device Policies</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Inactivity</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Compromised</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Encryption</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Model</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Operating System</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Require ActiveSync Profile</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Email Security Policies</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Email Security Classification</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachments (managed devices)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Attachments (unmanaged devices)</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hyperlink</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Activate an Email Compliance Policy

The email compliance policies available on the UEM console are General Email Policies, Managed Device Policies, and Email Security Policies. You can activate any of these email compliance policies or edit the rules for these email policies to allow or block the devices.

To activate an email policy:

1. Navigate to **Email > Compliance Policies**. By default, the policies are disabled and are denoted by a red colored circle under the **Active** column.

2. Use the edit policy icon under the **Actions** column to edit any of the rules for a policy.

   - **General Email Policies** – Enforce policies on all devices accessing email. When you choose a user group, the policy applies to all the users of that group.
### Sync Settings

Prevent the device from syncing with specific EAS folders.

- Workspace ONE UEM prevents devices from syncing with selected folders irrespective of other compliance policies.
- For the policy to take effect, it is necessary to republish the EAS profile to the devices (this forces devices to resync with the email server).

### Managed Device

Restrict email access only to managed devices.

### Mail Client

Restrict email access to a set of mail clients.

- You can allow or block mail clients based on the client type such as **Custom** and **Discovered**.
- You can also set default actions for the mail client and newly discovered mail clients that do not display in the Mail Client drop-down menu. For the custom client type, wildcard (*) characters and auto-complete are supported.

### User

Restrict email access to a set of users. You can allow or block user type that includes Custom, Discovered, Workspace ONE UEM User Account, and Workspace ONE UEM user group. You can also set default actions for email usernames that do not display in the Username or Group drop-down menu. For the custom user type, wildcard (*) characters and auto-complete are supported.

### EAS Device Type

Whitelist or blacklist devices based on the EAS Device Type attribute reported by the end-user device. You can allow or block devices based on the client type that includes Custom and Discovered mail client. You can also set default actions for the EAS device types that do not display in the Device Type drop-down field. For the custom client type, wildcard (*) characters and auto-complete are supported.

- **Managed Device Policies** – Enforce policies on managed devices accessing email.

<table>
<thead>
<tr>
<th>Email Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inactivity</td>
<td>Prevent inactive, managed devices from accessing email. You can specify the number of days a device shows up as inactive (that is, does not check in to VMware AirWatch), before Workspace ONE UEM prevents email access. The minimum accepted value is 1 and maximum is 32767.</td>
</tr>
<tr>
<td>Device Compromised</td>
<td>Prevent compromised devices from accessing email. This policy does not block email access for devices that have not reported compromised status to AirWatch.</td>
</tr>
<tr>
<td>Encryption</td>
<td>Prevent email access for unencrypted devices. This policy is applicable only to devices that have reported data protection status to AirWatch.</td>
</tr>
<tr>
<td>Model</td>
<td>Restrict email access based on the platform and model of the device.</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>Operating System</td>
<td>Restrict email access to a set of operating systems for specific platforms.</td>
</tr>
<tr>
<td>Require ActiveSync Profile</td>
<td>Restricts email access to devices which are not managed with an Exchange ActiveSync profile.</td>
</tr>
</tbody>
</table>

- **Email Security Policies** – Enforce policies on attachments and hyperlinks. This policy is applicable for SEG deployments only. For more information, see Email Content, Attachments & Hyperlinks Protection on page 39.

<table>
<thead>
<tr>
<th>Email Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Security Classification</td>
<td>Define the policy for the SEG to take on emails with tags and without tags. You can use the predefined tags or create tags using the Custom option. Based on the classification, you can either choose to allow or block the email in AirWatch Inbox and other email clients.</td>
</tr>
<tr>
<td>Attachments (managed devices)</td>
<td>Encrypt email attachments of the selected file types. These attachments are secured on the device and are only available for viewing on the VMware Content Locker. Currently, this feature is only available in managed iOS, Android devices, and Windows Phones with the Content Locker application. For other managed devices, you can choose to either allow encrypted attachments, block attachments, or allow unencrypted attachments.</td>
</tr>
<tr>
<td>Attachments (unmanaged devices)</td>
<td>Encrypt and block attachments or allow unencrypted attachments for unmanaged devices. Encrypted email attachments are not viewable on unmanaged devices. This feature is intended to maintain email integrity. If an email with an encrypted attachment is forwarded from an unmanaged device, the recipient can still view the attachment on a PC or another mobile device. For the maximum use of SEG, Workspace ONE UEM recommends using SEG for the attachment encryption and hyperlink transformation that can be accessed using AirWatch Inbox for iOS, Android, and the Native Mail Client for iOS and Android.</td>
</tr>
</tbody>
</table>
Hyperlink | Allow device users to open hyperlinks contained within an email directly with VMware Browser present on the device. The Secure Email Gateway dynamically modifies the hyperlink to open in VMware Browser. You may choose one of the Modification Type:
- All - Choose to open all the hyperlinks with VMware Browser.
- Exclude - Choose if you do not want the device users to open the mentioned domains through the VMware Browser. Mention the excluded domains in the Modify all hyperlinks except for these domains field. You can bulk-upload the domain names from a CSV file as well.
- Include - Choose if you want the device users to open the hyperlinks from specified domains through the VMware Browser. Mention the included domains in the Only modify hyperlinks for these domains field. You can bulk upload the domain names from a .csv file as well.

3. Create your compliance rule and Save.
4. Select the gray circle under the Active column to activate the compliance policy. A page appears with a key code.
5. Enter the key code in the corresponding field and select Continue. The policy is activated and shows a green colored circle under the Active column.

Email Content, Attachments & Hyperlinks Protection
Workspace ONE UEM helps you protect and control the mobile email attachments that are vulnerable to data loss for both managed and unmanaged devices. Workspace ONE UEM allows device users to open hyperlinks in an email directly with VMware Browser present on the device. The Secure Email Gateway dynamically modifies the hyperlink to open in VMware Browser.

Pre-Requisites
In order to start protecting your email attachments, ensure you have the listed items.
- Secure Email Gateway (SEG)
- VMware Content Locker (iOS, Android, and Windows Phone)
- Support for Microsoft Exchange 2010/2013/2016, IBM Notes, Novell GroupWise, and Gmail

Enable Email Security Classification
You can select the security classifications on the UEM console against which you want the Secure Email Gateway (SEG) to take action. There is a list of pre-defined security classifications to choose from as well as the option to create your own custom classification.
To enable email security classification:

1. Navigate to Email > Compliance Policies > Email Security Policies.

2. Select the gray colored circle under the Active column for the Email Security Classifications compliance policy. A page appears with a key code.

3. Enter the key code in the corresponding field and select Continue. The policy gets activated and is indicated by a green colored circle under the Active column.

4. Select the Edit option under the Actions column.

5. Select Add and then select the type of tag from the Type drop-down menu. Options available are Pre-defined and Custom. Select the tag type as Pre-defined to get a list of available tags from the Security Classification drop-down menu. Select the tag type as Custom to enter your own custom tag in the Security Classification field.

6. Enter a Description for the tag and select Next.

7. Configure the actions that SEG should take against emails marked or not marked with a tag. You may choose to allow or block emails on AirWatch Inbox or other email clients. Select Next.

8. View the Summary and Save.

Enable Email Attachment Protection

Email attachments are of various file types. On the UEM console, you can select the files types for which the email attachments must be encrypted by the Workspace ONE Secure Email Gateway (SEG). These encrypted attachments are secured on the mobile devices and can be viewed using the VMware Content Locker application.

Granular settings are available for managed iOS, Android devices, and Windows Phone. For other managed devices and all unmanaged devices, attachments can be prevented (in-bulk) from being opened in third-party apps.

To enable email attachment protection:

1. Navigate to Email > Compliance Policies > Email Security Policies.

2. Select the gray colored circle under the Active column for the Attachments (Managed devices) or Attachments (Unmanaged devices) compliance policy. A page appears with a key code.

3. Enter the key code in the corresponding field and select Continue. The policy is activated and is denoted by a green colored circle under the Active column.

4. Select the Edit option under the Actions column.

5. Select whether to encrypt & allow or block or allow without encryption attachment for each file category (for managed iOS, Android and Windows devices only).

6. Select the check box Allow Attachments to be saved in Content Locker to save the attachments in Content Locker. The attachments remain encrypted and Content Locker policies applies.

7. Choose the policy for any Other Files not mentioned here.

8. Enter file extensions that are to be excluded from the actions configured in Other Files into the Exclusion List.

9. Enter a Custom Message for Blocked Attachments to inform the recipient that an attachment has been blocked.
10. **Save** the settings.

### Attachment Security Policies - Managed Devices

<table>
<thead>
<tr>
<th>File Category</th>
<th>Encrypt &amp; Allow Attachment</th>
<th>Block Attachments</th>
<th>Allow Attachments without Policy</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Documents</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keynote</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Numbers</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Pages</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Excel</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Powerpoint</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PDF</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(CSS, HTML, RichText)</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Video</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(MP4, MOV)</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(AAC, AMR, M4A)</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Images</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>(PNG, JPG, TIFF)</td>
<td>*</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Zip</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**iOS, Android & Windows**

- Use Recommended Settings

**Save**

---

*Email attachments of selected file types will be encrypted by the AirWatch Secure Email Gateway. These attachments will be secured on the device and will only be available for viewing on the AirWatch Control Locker. Currently, this feature is only available on the platforms listed below with the Control Locker application. For other managed devices, you can choose to either allow encrypted attachments, block attachments or allow unencrypted attachments.*
Enable Hyperlink Protection

Using the hyperlink email security policy, you can control the hyperlinks in the emails to be modified so that these can be opened directly with VMware Browser.

To enable hyperlinks protection:

1. Navigate to Email > Compliance Policies > Email Security Policies.

2. Select the gray colored circle under the Active column for the Hyperlink compliance policy. A page appears with a key code.

3. Enter the key code in the corresponding field and select Continue. The policy is activated and is denoted by the green colored circle under the Active column.

4. Select the Edit option under the Action column.

5. Select the platform for which you want to ignore the hyperlink transformations for AirWatch Inbox.

6. Select one of the Modification Type:
   
   - All - Choose to open all the hyperlinks with VMware Browser.
   
   - Include - Choose if you want the device users to open the hyperlinks from specified domains through the VMware Browser. Mention the included domains in the Only modify hyperlinks for these domains field. You can bulk upload the domain names from a CSV file as well.
   
   - Exclude - Choose if you do not want the device users to open the mentioned domains through the VMware Browser. Mention the excluded domains in the Modify all hyperlinks except for these domains field. You can bulk upload the domain names from a CSV file as well.

7. Save the settings.
Chapter 9: Email Management

Email Dashboard

You can monitor your user group's email traffic and devices through the UEM console Email Dashboard. This dashboard gives you a real-time summary of the status of the devices connected to the email server. You can access the dashboard from Email > Dashboard.

From the dashboard, you can also use the available graphs to filter your search. For example, if you want to view all the managed devices of an organization group, select the Managed Devices graph. The graphs display the results in the List View page.

Email List View

The Email > List View page allows you to view all the real-time updates of your end-user devices that you are managing with Workspace ONE Mobile Email Management (MEM). You can view the device or user-specific information either as a
summarized list or as a customized one based on your requirement.

Switch between the Device and User tabs to view the user and device information. In order to view the summary or the customized list of the information, change the Layout.

List View page enables you to:

- Whitelist or blacklist a device to allow or deny access to email respectively.
- View the devices which are managed, unmanaged, compliant, non-compliant, blocked, or allowed.
- View the device details such as OS, Model, Platform, Phone Number, IMEI, and IP address.

List View page provides detailed information that includes:

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Request</td>
<td>The last state change of the device either from Workspace ONE UEM or from Exchange in the PowerShell integration. In SEG-integration this column shows the last time a device synced mail.</td>
</tr>
<tr>
<td>User</td>
<td>The user account name.</td>
</tr>
<tr>
<td>Friendly Name</td>
<td>The friendly name of the device.</td>
</tr>
<tr>
<td>MEM Config</td>
<td>The configured MEM deployment that is managing the device.</td>
</tr>
<tr>
<td>Email Address</td>
<td>The email address of the user account.</td>
</tr>
<tr>
<td>Identifier</td>
<td>The unique alpha-numeric identification code associated with the device.</td>
</tr>
<tr>
<td>Mail Client</td>
<td>The email client syncing the emails on the device</td>
</tr>
<tr>
<td>Last Command</td>
<td>The last state change of the device and populates the Last Request column.</td>
</tr>
<tr>
<td>Last Gateway Server</td>
<td>The server to which the device connected.</td>
</tr>
<tr>
<td>Status</td>
<td>The real-time status of the device and whether email is blocked or allowed on it as per the defined policy.</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason code for allowing or blocking email on a device.</td>
</tr>
</tbody>
</table>

- The reason code is 'Global', if the default organization's Allow, Block, or Quarantine policies define the access state. The reason code is 'Individual' when the device ID is explicitly set for a given mailbox by Exchange admin or Workspace ONE UEM. The reason code is 'Policy', if any EAS policy blocks the device.

- Workspace ONE UEM provides you with the option to block emails on non-compliant devices (such as devices with blacklisted apps). Emails are enabled once the devices become compliant. You can view the list of non-compliant devices on the Email Dashboard marked with the reason tag as 'MDM Compliance'.

- **Platform, Model, OS, IMEI, EAS Device Type, IP Address** - The device information displays in these fields.
- **Mailbox Identity** - The location of the user mailbox in the Active Directory.

💡 For more information on the Last command and Reason values, see the following Knowledge Base article [https://support.air-watch.com/articles/115001676188](https://support.air-watch.com/articles/115001676188).

### Filters

Narrow the device search using the **Filter** option on the List View page.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Seen</td>
<td>All, less than 24 hours, 12 hours, 6 hours, 2 hours.</td>
</tr>
<tr>
<td>Managed</td>
<td>All, Managed, Unmanaged.</td>
</tr>
<tr>
<td>Allowed</td>
<td>All, Allowed, Blocked.</td>
</tr>
<tr>
<td>Policy Override</td>
<td>All, Blacklisted, Whitelisted, Default.</td>
</tr>
<tr>
<td>Policy Violation</td>
<td>Compromised, Device Inactive, Not data Protected/Enrolled/MDM Compliant, Unapproved EAS Device Type/Email Account/Mail Client/Model/OS</td>
</tr>
<tr>
<td>MEM Config</td>
<td>Filter devices based on the configured MEM deployments.</td>
</tr>
<tr>
<td>EAS Device Type</td>
<td>Filter based on the device type.</td>
</tr>
<tr>
<td>Email Address</td>
<td>Filter based on email address.</td>
</tr>
<tr>
<td>Last Gateway Server</td>
<td>Filter based on the available Secure Email Gateway server.</td>
</tr>
</tbody>
</table>

### Email Actions

The **Override, Actions**, and the **Administration** drop-down menu provides a single location to perform multiple actions on the device.

**Important:** These actions cannot be undone.

### Override

Select the check box corresponding to a device to perform actions on it. Whitelist or blacklist a device irrespective of the compliance policy and revert to the policy when needed.

- **Whitelist** - Allows a device to receive emails.
- **Blacklist** - Blocks a device from receiving emails.
- **Default** - Allows or blocks a device based on whether the device is compliant or non compliant.
Actions

- **Sync Mailboxes** - Queries the Exchange server for an updated list of devices that have attempted to sync email (Direct PowerShell Model). If you do not choose this option, the unmanaged device list does not change unless one of the unmanaged devices is enrolled into Workspace ONE UEM or you manually whitelist or blacklist a device, so initiating a state change command.

Workspace ONE UEM offers the Email Sync option within the Self-Service Portal (SSP) so that end-users can sync their devices with the mail server and also run preconfigured compliance policies for all their devices. This process is typically much faster than the bulk sync performed on all the devices.

- **Run Compliance** - Triggers the compliance engine to run for the selected MEM configuration. This command operates differently when using the PowerShell model versus the SEG model.
  - If SEG is configured, this command updates SEG with the latest compliance policies.
  - If the PowerShell model is configured, this command manually runs a compliance check on all devices and blocks or allows device access to email.

When the Direct PowerShell Model is configured, Workspace ONE UEM communicates directly to the CAS array using remote signed PowerShell sessions established from the console server or VMware Enterprise Systems Connector (depending on the deployment architecture). Using remote signed sessions, PowerShell commands are sent to blacklist (block) and whitelist (allow) device ID’s on a given users CAS mailbox in Exchange 2010/2013 based on the device’s compliance status in Workspace ONE UEM.

- **Enable Test Mode** - Tests email policies without applying them on devices of SEG-integrated deployments.

Administration

Select the check box corresponding to a device to perform actions on it.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enrollment Email</td>
<td>Sends an email to the user with all the details required for enrollment. On discovering an unmanaged device, send an enrollment email asking the user to enroll the device (PowerShell only).</td>
</tr>
<tr>
<td>Dx Mode On</td>
<td>Runs the diagnostic for the selected user mailbox providing you the history of the device activity. This feature is available for SEG only.</td>
</tr>
<tr>
<td>Dx Mode Off</td>
<td>Turns off the diagnostic for the selected user mailbox.</td>
</tr>
<tr>
<td>Update Encryption Key</td>
<td>Resets the encryption and then resyncs the emails for the selected devices.</td>
</tr>
<tr>
<td>Remote Wipe</td>
<td>Resets the device to factory settings. Perform an Enterprise Reset (reset to factory settings) on a lost or stolen device containing sensitive information (PowerShell only).</td>
</tr>
<tr>
<td>Delete Unmanaged Devices</td>
<td>Deletes the selected unmanaged device record from the dashboard.</td>
</tr>
<tr>
<td>Migrate Devices</td>
<td>Migrate devices across organization groups and MEM deployments.</td>
</tr>
<tr>
<td>Sync Selected Mailbox</td>
<td>Syncs the selected device mailbox. Only one device mailbox at a time can be synced.</td>
</tr>
</tbody>
</table>
Note: This record may reappear after the next sync.

**Checking for Unmanaged Devices**

To make sure all your devices are managed and monitored, navigate to the List View page. From List View page, filter the unmanaged devices and then send an enrollment mail from the Administration drop-down menu.